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Preface

AdvanceLink for NewWave provides HP and DEC VT100
terminal emulation in the HP NewWave environment. Most
of its features operate identically to those of AdvanceLink for
Windows and are covered in the AdvanceLink Reference (MS-
Windows).

AdvanceLink's script language, TermTalk, is also used with
Advancelink for NewWave, as documented in the TermTalk
manual. For an overview of NewWave-specific commands,
see "Working with HP NewWave" in Chapter 3 of TermTalk.

The current manual is a supplement to the AdvanceLink for
Windows documentation. It describes installation under
NewWave and the use of NewWave features, organized as
follows:

B Chapter 1, NewWave Features, provides an overview of
AdvanceLink's special NewWave features.

m  Chapter 2, Getting Started, provides installation
instructions and a discussion of AdvanceLink objects and
TermTalk objects.

u  Chapter 3, Drag and Drop, explains what happens when
you drag or paste objects into an AdvanceLink object.

m  Chapter 4, The Menus, explains the differences between

the menus of AdvanceLink for NewWave and those of
AdvanceLink for Windows.

m  Chapter 5, Task Language, lists the commands that
compose AdvanceLink's task language.
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Overview 1

AdvanceLink for NewWave is an HP 2392, HP 700/94 and
VT100 terminal emulator for the HP NewWave environment.
Once you have connected your PC to an HP 3000, HP 9000,
HP 1000, DEC VAX, or other system by direct cable, modem,
or network, AdvanceLink allows you to access the data,
applications, and storage capacity of the host as if you were
using an HP terminal. AdvanceLink for NewWave also
includes TermTalk, a scripting language that automates
terminal-based functions.

NewWave Features

AdvanceLink for NewWave adds two kinds of objects to your
NewWave Office: AdvanceLink objects and TermTalk objects.
An AdvanceLink object, when open, provides a terminal
emulation window in which you can connect to and
communicate with a host computer. A TermTalk object is a
script containing commands which control AdvanceLink,
instructing it to perform a series of terminal emulation
functions.

In general, AdvanceLink for NewWave operates just as
AdvanceLink for Windows does, according to the
documentation in the AdvanceLink for Windows Reference.
Special NewWave extensions to the capabilities of
AdvanceLink for Windows are documented in this
supplement. These extensions are:

® Dragging and dropping or pasting any NewWave object
other than a TermTalk object into an open AdvanceLink
window initiates transfer of the object to a host computer.
(Unlike a tool object like the Waste Basket, the
AdvanceLink object must be open for drag and drop to

Chapter 1: Overview 1
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Chapter 1: Overview

work.) To do something other than initiate file transfer
(for example, to customize the file transfer procedure, or
even to disable file transfer) upon object drop or paste, you
can specify a TermTalk script object which is executed
instead of file transfer.

Dragging and dropping a TermTalk object into an open
AdvanceLink window executes the commands contained
in that object. Pasting a TermTalk object into the window
initiates transfer of the object to the host computer.

NewWave-style help is provided for all screen elements
and a help button is included in each dialog box.

To support the development of computer based training
(CBT) applications, AdvanceLink for NewWave allows
command monitoring. This allows you to build an Agent
task which runs an interactive CBT lesson, as described in
"Computer-Based Training Developer Guide" included in
the Hewlett-Packard NewWave Environment Developer
Kit.



Automating
Computer
Functions

While AdvanceLink for NewWave provides automation of
terminal-based functions through the use of the TermTalk
script language, it also includes a set of task language
commands which are used by the NewWave Agent to
automate tasks which involve the use of AdvanceLink. The
differences between the NewWave Agent task language and
the TermTalk script language are outlined in the table below.

NewWave Agent TermTalk

Creates tasks which Limited in operation to
can integrate any the single

number of different AdvanceLink object
tools and objects, running the script
including

AdvanceLink

Takes over Can run in background
workstation while while user or agent

running; user cannot
do anything else
while task in progress

performs some other
activity

Limited control of Thorough control of
handshaking and host communications
timing for host including flexible
communications manipulation of timing
and handshaking
Can set but not Can set and retrieve
retrieve all basic basic configuration
configuration settings settings, as well as

low-level data comm
parameters

To illustrate the differing functions of Agent tasks and

TermTalk scripts, assume you want to automate the process
of backing up several NewWave objects to the host computer.
First, let us examine how you would perform this procedure

interactively.

1. You open an AdvanceLink object.

Chapter 1: Overview 3



2. Youlog on to the host.

3. You drag and drop each NewWave object to be
transferred to the host into the AdvanceLink window,
one at a time. After you drop each object, a Send File
dialog box is displayed in which you can confirm or
modify transfer options.

4. You log off.
5. You close the AdvanceLink object.

While this whole procedure could be recorded and later
performed by the NewWave Agent with no TermTalk script
objects involved, better control of the timing involved in
logging on and logging off is provided by TermTalk.
TermTalk script objects which log on and log off the host can
be executed automatically upon opening and closing of the
AdvanceLink object. Once you have set up an AdvanceLink
object which logs on when opened and logs off when closed,
this object can be used by any other task or interactive user
who needs to communicate with the host.

Each AdvanceLink object can have one TermTalk script object
which is executed automatically upon opening, and one
which is executed automatically upon closing. To create such
a script object, you might select the Record A Script
command from AdvanceLink's Script menu, perform the
desired actions, then select Stop Recording from the same
menu. You then use the Script command on AdvanceLink's
Settings menu to designate this script as the one to be
executed upon the opening or closing of the object.

If you did create the opening and closing scripts described
above, the backup procedure would be automated as follows.

1. The NewWave Agent opens an AdvanceLink object.

Chapter 1: Overview



2. The AdvanceLink object automatically executes a script
which logs on to the host.

3. The NewWave Agent drags and drops each NewWave
object to be transferred to the host into the AdvanceLink
window, one at a time. After dropping each object, the
Agent sets transfer options using the SEND_OBJECT
command (one of the commands AdvanceLink adds to
the Agent task language). This corresponds to the Send
File dialog normally completed by the user.

4. The NewWave Agent closes the AdvanceLink object,
which logs off automatically.

Another possibility for Step 3 would be to set up a TermTalk
script which replaces the simple initiation of file transfer
upon object drop with a more complex script which not only
initiates transfer but specifies all options, and perhaps goes
on to move the documents which have been backed up into
different groups on the host computer. Each AdvanceLink
object can have one TermTalk script object which is executed
automatically upon object drop and paste, replacing the
default action of initiating file transfer. Such a relationship is
established using the Script command on AdvanceLink's
Settings menu.

The sophisticated functions of Agent tasks and TermTalk
scripts are illustrated by a further example. Suppose you
wanted to produce a graph of the fluctuations of a particular
stock price every morning. This procedure could be
automated with the following steps.

1. The NewWave Agent opens a speadsheet object and an
AdvanceLink object.

2. The AdvanceLink object automatically executes a script
which sets communications parameters, dials a modem,
and logs on to the online service which provides stock
prices.

Chapter 1: Overview 5



3. The Agent uses the SET_VARIABLE command (one of the
commands AdvanceLink adds to the Agent task
language) to set up a permanent variable with the name
of the stock in question. The Agent then executes a
TermTalk script object with the DO_SCRIPT OBJECT
command (another AdvanceLink addition to the task
language.) During the execution of the script object, the
Agent is suspended.

4. The script object retrieves the name of the stock price to
be looked up from the permanent variable, then finds its
current price using the online service. The timing,
handshaking, and management of display memory
required by this process are smoothly handled by
TermTalk commands. The price is placed in a second
permanent variable.

5. When the script completes, the Agent resumes task
execution. The Agent retrieves the stock price from the
second permanent variable using the VARIABLE function
(added by AdvanceLink to the Agent task language.) It
then pastes the value into the spreadsheet object.

If multiple stocks are to be monitored, steps 3 through 5
could be repeated.

6. The Agent closes the AdvanceLink object. A script which
logs off the online service and hangs up the modem is
executed automatically.

7. The Agent produces and prints a graph using the
spreadsheet object, then closes that object.

To update the graph on a daily basis, the Agent's Calendar

could be used to schedule the task to run every weekday at
6 AM.

6 Chapter 1: Overview



Getting Started 2

i To install AdvanceLink for NewWave, insert the disk labelled
Installat_lon "AdvanceLink Volume 1" into drive A and run the INSTALL
Instructions procedure. This procedure is run under MS-DOS before

loading Windows or NewWave.
C: A: [Enter)

A: INSTALL C: (orother drive where the NewWave
directory, \HPNWDATA, is located)

To install from a drive other than drive A, use the DOS
ASSIGN command. For example, if you are on drive C and
wish to install AdvanceLink from drive B, enter the following
commands:

C: ASSIGN A=B
C: A: [Enter

A: INSTALL C: (orother drive where the NewWave
directory, \HPNWDATA, is located)

The installation procedure loads NewWave and instructs it to
copy the necessary files from the AdvanceLink Master disk.
Halfway through the procedure, you will be prompted to
insert "Volume 2." Insert the disk labelled accordingly.

Once this phase of installation is complete, you can create an
AdvanceLink object by selecting Create a New... from the
Objects menu of the NewWave Office, then selecting the
AdvanceLink icon from the list of NewWave objects.

Chapter 2: Getting Started 7



- Once installed in the NewWave Office, AdvanceLink can
égyallcengk create two types of objects: AdvanceLink objects and
Jects an . TermTalk objects.
TermTalk Objects
Croates an
A:_"a"ceu"k Select an Object Type To Creatr——
object I
FoI-der Newwivewme TemTalk Ahoeum TextNote
Jitle For New Dbject:
Creates a [ne 3898 e
TermTalk =2 —l
object L 0K ] 1 l:anl:el—l ! Help —I

An AdvanceLink object is created by selecting Create a New
from the Objects menu of the NewWave Office, then choosing
the AdvanceLink icon from the list of NewWave objects.
When opened, an AdvanceLink object provides a terminal
emulation window in which you can communicate with a
host computer.

A TermTalk object is created by selecting Create a New from
the Objects menu of the NewWave Office, then choosing the
TermTalk Script icon from the list of NewWave objects. A
TermTalk object can also be created using the Create button
in AdvanceLink's Script Settings dialog box (select Script
from the Settings menu of the AdvanceLink window). A
TermTalk object is a script which automates AdvanceLink
functions.

8 Chapter 2: Getting Started



Action Edit Qbjects Yiew Settings Task
Help
> K’
] R &2 N |
File Drewer Printers  Agent Waste Basket
Advancelink
object E«‘
TermTalk HP3000
ermTa
object B
Logon Script
Yy

When you open an AdvanceLink object by double-clicking it
or by selecting Open from the Objects menu of the NewWave
Office, you get an AdvanceLink window in which you can
communicate with a host computer.

- NewWave Ofice v|a
Acton Edit Sewings Utihy Keys Lag Script Tesk Help *
Break | Reset [Ins Line[Del Line[Ins char|el char]clr Line[cir Disp] Hmﬂp'@
X
*

o]

ulf::rslm fslfslnlnl
21 J

When you open a TermTalk object by double-clicking it, by
selecting Open from the Objects menu of the
NewWaveOffice, or by using the Open button in the Script
Settings dialog box (select Script from the Settings menu of
the AdvanceLink window), you get a text editing window in
which you can create and edit a script which controls

Chapter 2: Getting Started 9
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AdvanceLink using commands from the TermTalk script
language.

=) NewWave Office -
Acion Edt Font Control Help +]
Ll oy
o
* Ld
Editin Line 1
L3
* >

Multiple connection and script windows can be open at once,
and are independent of each other. To link a particular
TermTalk object to a particular AdvanceLink object for the
purpose of automatic script recording, use the Set Script
Window command on the AdvanceLink Script menu. This
connection lasts only as long as the windows are open; it is
not saved with the objects.

Unlike most NewWave objects (but like the NewWave Office
itself), an AdvanceLink object can be iconized. This means
that the window is closed and the object appears on the
Windows desktop outside the NewWave Office window.
Meanwhile, any processing that is in progress continues
uninterrupted. This is especially useful during the execution
of lengthy file transfers. To iconize a connection window,
click the downward-pointing arrow in the upper right corner.

Click to iconize window

- HP U0 (Advane eLink) [~] <]

Chapter 2: Getting Started




Compound Objects

Linked TermTalk
objects are listed
here, and can be
displayed on the
menu or executed
automatically on
open, close, drop or
paste.

Unlike Windows applications, an iconized AdvanceLink
object does not display the Control menu when you click it.
Double-click the icon to re-open the window.

In the same way that a NewWave Write object can contain or
share graphics objects, spreadsheet objects, and so on, an
AdvanceLink object can contain or share one or more
TermTalk objects. These linked objects can:

® Be listed on the Script menu of the AdvanceLink object.
B Be associated with a particular function key.

® Be automatically executed upon opening or closing of the
AdvanceLink object.

B Replace file transfer as the default action when a non-
TermTalk object is dragged and dropped or pasted into the
AdvanceLink object.

TermTalk objects which are used in this way, as well as any
nested TermTalk objects called by these objects and any
scripts to be executed with host control escape sequences,
must be listed in the Script Settings dialog box (select Script
from the Settings menu of the AdvanceLink window.) This
dialog box is illustrated below.

F_

| Open l Cut
Get Mall
Backup PC Flles [ Delete | [ gopy ]
Logon [ Cemte | rﬁhl ﬂ
|
Digplay in menu
Auto execute on:
[ open
X Close
{7 Object drop or paste [Donc | [ Hep |
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If an AdvanceLink object is exported to DOS or transferred to
a host computer (possibly for the purpose of distributing it to
other NewWave users), all linked objects are moved with: it.

For more information on the Script Settings dialog box, see
Chapter 4.

Installing the File
Transfer Link
Program

To perform file transfers with HP 3000 and 9000 host systems,
you must install HPLink, the file transfer link program, on the
host s with which you plan to transfer files. To do so, first
run AdvanceLink and set the configuration values described
in "Installing the Host Program” in Chapter 4 of the
AdvanceLink Reference (MS-Windows). Then follow these steps:

B Locate Volume 2 of your AdvanceLink installation disks
and insert it into your disk drive.

8 Select Import from Disk File from the Objects menu of
the NewWave Office. Then select the file install.ser
from the disk you have just inserted. Once imported, this
file appears as a TermTalk object called "Install HPLINK
on host" in your NewWave Office.

®  Drag "Install HPLINK on host" into the AdvanceLink
window in which you have set configuration values and
logged on. This initiates execution of the installation
script object.

The first thing the installation script does is ask whether you
are installing on an HP 3000 or an HP 9000. Once you click
the desired button, an informational dialog box is displayed.
When you click Install in this box, AdvanceLink looks for a
copy of HPLink in the directory from which AdvanceLink
was run. If it is not there, AdvanceLink prompts you to insert
the HPLink master disk in drive A.

For more information, refer to Chapter 4 of the AdvanceLink
Reference (MS-Windows).

12 Chapter 2: Getting Started



Drag and Drop 3

P You can drag and drop any NewWave object into an open
Trqnsfe rring Advancel.ini windovg anc); you can paste]?r:\y object which is
Ob]eCts to the Host on the NewWave clipboard into the AdvanceLink window
using the Paste command from the Edit menu of the
AdvanceLink window. The window must be open for drag
and drop or paste to work.

] NewWave Office v]a
Action Edit QObjects View Scttings Jask Help

N O
Action Edit Setings Uittty Keys Log Script Jask
Help

Break | Reset |Ins Line|Del Line]Ins Char]pe1 char|cir {8
any NewWave ]!

objectintothe == == =" """’ """ sl ot O i
Advancelink Report
window lo
initiate fle

transfer. Eo'] |g .

File Drawar  Agent
£} 2 [£] 4 5 f
1 il :
Waste Baskst £l _cl 2

Drag and drop

K4
L]

Dropping or pasting any object that is not a TermTalk object
initiates file transfer as currently configured in the File
Transfer Settings box (select File Transfer from the Settings
menu of the AdvanceLink window). Immediately after you
drop or paste the object, the Send File dialog box shown on
the next page is displayed. See the chapter titled "File
Transfer" in the AdvanceLink Reference (MS-Windows) for an
explanation of the options in this dialog box.

Chapter 3: Drag and Drop 13
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Note

PC File to be Sent to HP3000: Text File
HP3000 File

l Report ] NewWave
Other

HP3000 File Characteristics
Name

[REPOR]
Rec Size {Bytes < Ascif

@ words @ Binary

{2 Convert 1o EDITOR farmat, word wrap
< Convert to EDITOR, retain lines
Q Binary transfer

O Backup PC Flle

{ Restore HP3000 file

@ NewWave SOF Package

There is a Send File command on the AdvanceLink's Action
menu but it is only used to send DOS files. To send
NewWave objects you must use drag and drop or the Paste
command on the AdvanceLink's Edit menu. If you choose
the Send File command from AdvanceLink's Action menu,
only DOS file names are accepted and NewWave transfer
options are not available.

By default, NewWave objects are transferred in the
NewWave Serialized Object Format (SOF). This creates a
copy of the object, including all linked objects and underlying
files, in a format that can be restored using the NewWave
SOF conversion option in AdvanceLink's Receive File dialog
box. The SOF format is also recognized by some HP 3000
applications, including HP DeskManager. In an HP 3000
LISTF directory listing, these files have the file type "SOF."

It is also possible to transfer the NewWave object with the
"Binary transfer” or "Backup PC file” conversion options.
These options send all the information described above

Chapter 3: Drag and Drop




Changing the Default

If you choose this option,
the selected script will be
executed when an objact

Computers
Museum

without the SOF file marker which identifies the file as a
NewWave object.

To receive both DOS and NewWave files, use the Receive
File command on the Action menu of the AdvanceLink
window. When you receive a NewWave file, the default
conversion is "NewWave SOF package,” which restores the
object into the NewWave Office. You can also select "Binary
transfer,” which receives the object as a DOS file. You might
then put this DOS file on a flexible disk to pass onto other
NewWave users, who could import it into their NewWave
Offices.

To do something other than initiate file transfer (or to
customize the file transfer procedure, or even to disable file
transfer) when an object is dropped or pasted into the
AdvanceLink window, specify the TermTalk object to be
executed in the Script Settings dialog box (select Script from
the Settings menu of the AdvanceLink window.)

Tog OF [ Open || cut ]
Get Mall

Backup PC Flles [[Delete | | Copy |
Logon

| Create I | Shm—l

[ Displey In menu
Auto execute on:

is pasted or dropped into O open
the Advancelink [ clese
window. —{"] Object drop er peste I Done | I Help —l
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Executing and
Transferring
TermTalk Objects

Drag and drop a
TermTalk script
objectintothe == ===
Advancelink

window fo execute

that script.

| I T

You can execute any TermTalk object by dragging and
dropping it into the AdvanceLink window. The window
must be open for this procedure to work.

NewWave Office v]a
Action Edit Objects View Sctiings Task Help

Acon Edit Settings Uity Keys Log Sgript Tesk

Help

Break | Reset [Ins Line]Del Line]ins Char|pel char]cir M|
X

hd

[ I 2 I 13 Lﬂ m_n
&)
cl_ci L]

Since dropping a TermTalk object into the AdvanceLink
window executes the script instead of transferring it to the
host, you must use the Paste command on the Edit menu of
the AdvanceLink window to transfer a TermTalk object.
Select the TermTalk object you wish to transfer, choose Share,
Copy, or Cut from the NewWave Office Objects menu to
place it on the Clipboard, then select Paste from the Edit
menu of the AdvanceLink window. AdvanceLink's Send File
dialog is then displayed.

16 Chapter 3: Drag and Drop




AdvanceLink Menus 4

Note

This section covers only the menu commands which are
different from those of AdvanceLink for Windows.
Commands which operate identically are discussed in the
AdvanceLinkReference (MS-Windows). TermTalk menus are
covered in the TermTalk manual.

The AdvanceLink for NewWave menu bar contains nine
menus.

[Action Edit_Settings Utility Keys Log Script _Task Help]

The Action menu is similar to the File menu of AdvanceLink
for Windows; differences are discussed in this chapter.

The Edit menu is identical to that of AdvanceLink for
Windows. The Paste command, however, pastes objects as
well as text, as discussed in the preceding chapter.

On the Settings menu, there are differences in the Terminal,
Script, and Function Keys dialogs. These are discussed in
this chapter.

The Utility, Keys, and Log menus are the same. When you
select Print Logged, the data goes into the NewWave printer
queue.

Differences in the Script menu are discussed in this chapter.

Chapter 4: Advancel.ink Menus 17



Creste Menu Task...
Manage Menu Task...
Perform Menu Task.., F4

ﬁlﬂdm.. P
Screen/Menu Help... Shift+F1
The Task and Help menus are standard NewWave menus,
documented in your NewWave reference manuals. For help
with any screen element or menu item, select the
Screen/Menu Help command. The mouse pointer changes to
an arrow with a question mark on top of it. You place this
pointer on the element in question and click.

18 Chapter 4: AdvanceLink Menus



Action Menu

[ activy The Action menu contains commands which manage the
§:§ As... AdvanceLink object, control connection and printer status,
Reverl.. and initiate file transfer. It does not contain an Open
Cannect command because all objects must be opened from the
Disconnect NewWave Office by double-clicking or selecting Open from
Send File... NewWave's Objects menu.

Receive File...
Attributes...

Printer Setup...
Close

About AdvancelLink...

Save Updates the saved version of the AdvanceLink object with
the current status of the following commands:

B All settings made using commands from the Settings
menu.

®  Tab and margin settings.

B Status of the control bar.

B Status and contents of function key labels.

To load AdvanceLink with these configuration settings, open
the AdvanceLink object.

It is convenient to save an AdvanceLink object with each
configuration setup you frequently use. For example, you
could store the settings you use when you dial your modem
in an AdvanceLink object called Modem, and just open that
object to load that configuration.

Chapter 4: AdvancelLink Menus 19



Save As

Revert

Send File

Receive File

Save the current status of the configuration items listed above
to a new AdvanceLink object, which you name in the dialog
box shown below:

Save As

Titic for new Connection: | [RIERINIT

l oK | ICaneeI I Help I

The new object is placed in the NewWave Office. It is not
opened automatically. The configuration settings in the
currently-open AdvanceLink object are not changed by this
command.

The default name for the new object is the same as the current
session. Though in most cases you will want to modify this
name, it is possible under NewWave to have multiple objects
with the same name.

Returns all configuration settings to the values saved by the
last use of the Save command, or to the settings in effect
when the AdvanceLink object was opened if Save has not
been used.

Sends DOS files to remote computers. Use drag and drop or
the Paste command from the Edit menu to transfer NewWave
objects.

Receives DOS files and NewWave objects from remote
computers. The only difference in the operation of this
command and the identically-named command in
AdvanceLink for Windows is that, under NewWave, if the
file received is a Serialized Object Format (SOF) package, it
can be imported back into the NewWave Office instead of
remaining as a DOS SOF file.

20 Chapter 4: Advancelink Menus



Attributes

Close

About AdvanceLink

Displays the standard NewWave object attributes dialog box:

- HEJUUU [Attribate s)

Iitle: | STEETII | g

Type: Advancelink

Creator:

Malil Address:

Last Writer:

Mail Address:

Created: Links Up/Dn:
Modified: Bytes:

Slze:

Comments O Autoshared

dit

3 Help

The title configured here and the title in the Terminal Settings
dialog box (select Terminal from the Settings menu of the
AdvanceLink window) are the same — both are the name of
the object. Any change you make in that dialog box is carried
over to this one, and the changes you make here are reflected
there as well.

Closes the AdvanceLink object.

Shows which version of AdvanceLink you are using.

Chapter 4: Advancel.ink Menus 21



|
Settings Menu

Jerminal.

Lonneclion...

Coler...

Eunction Keys...
KeyboardiCharacter Set.

Filc Transfer...

Legging.
Seript.,

Terminal

Commands on the Settings menu operate just as the
corresponding commands in AdvanceLink for Windows do,
with the following exceptions.

The Terminal Settings dialog looks like this:

lenminal Setting:

Terminal Display

(Tﬂle ( Number of Screens
[HP3000 | || Number of Columns[80___[3]
Emulation Fomsize [14 o

Terminal ID Cursor type
70094 | @ Underline O Black

[] Maximize ta 24 by 80
& Show contret bar
X Show indicatars

| options ... | [ ok 1] [ cancet |

Title

The title shown here is the name of the AdvanceLink object.
This field is changed when you enter changes in the
Attributes dialog box, or when you change the name of the
AdvanceLink object when it is closed in the NewWave Office
window by clicking the name and modifying it as desired.

22 Chapter 4: AdvanceLink Menus




Function Keys Only TermTalk objects listed in the Script Settings dialog box
can be associated with a function key. When you click the
Script button in the following dialog box, only those
TermTalk objects are displayed.

Key Functien Label String or Script Attribute
Transmit !I | oK I
T it (& "U—hl
| Cancel I
i S | Script... I
[Tronsmit |+] |F!-F'|z __I
Fs [suing 3] 65 3 [Transmit |s] & Disp Fanca
F6 [String H 6 [T Tranemit !I
F7 EE‘ [ [ Transmit I!I
2 ] EEI—T‘ Eu Trenemit !l
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Script The Script Settings dialog box looks like this:

! |

Qpen I I Cut
I Dejete I | Copy |
| Create I | Share |

Get Mall
Backup PC Files
Logon

[ Display In menu
Auto execute on:

O open
ad Close

[ object drop or paste , Done | I HCLI

TermTalk object list

This list serves as a directory of linked TermTalk objects. Any
TermTalk object which is to be automatically executed,
displayed on the Script menu, associated with a function key
or executed by host control, as well as any nested script
executed by such a script, must be listed in this box. This is
so that the AdvanceLink object can locate each of these
TermTalk objects as they are needed.

To add an existing TermTalk object to this box, drag and drop
its icon into the dialog box window. This is an exception to
AdvanceLink's usual operation—dragging and dropping a
TermTalk object normally executes it. However, normal drag
and drop operation is disabled when the Script Settings
dialog box is open.

When a TermTalk object is dragged into the Script Settings
dialog, it is contained exclusively within the AdvanceLink
object and no longer appears in the NewWave Office.

An existing TermTalk object can also be moved into this box
from the Clipboard by clicking the Paste button in the dialog
box. If the object was cut or copied to the Clipboard, it is
contained exclusively within the AdvanceLink object. If it
was shared, references to the object exist both in its former
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location(s) and within the AdvanceLink object. It is the same
object, so modifications made in any location are reflected in
the rest.

A new script can be created and added to the list by clicking
the Create button. You are prompted for a name for the
TermTalk object and it appears at the bottom of the list.

To open any TermTalk object in the list for writing and
editing, select its name and click Open, or double-click its
name in the list box. The standard script window is
displayed.

To remove a script from the list, highlight its name and click
Delete.

To remove a script from the list and place a copy on the
Clipboard, highlight its name and click Cut.

To place a copy of a script on the list on the Clipboard,
leaving a copy in the list, click Copy. The two copies have the
same name but are independent of each other.

To place a reference to a TermTalk object on the list on the
Clipboard, click Share. When you paste the shared object,
references to it exist in both places. It is the same object, so
any changes you make to it in one location are seen in the
other.
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Dispiay in menu

To place a TermTalk object on the Script menu, highlight its
name and check this option. Up to ten scripts can be listed on
the Script menu. They are listed in the order they appear in
the Script Settings dialog. (To change the order, cut and paste
the scripts in the list box.)

The scripts appear on the Script menu with keyboard
shortcuts + 0 through + 9 assigned automatically.

Pause Script
Stop Script

Do Command...

Record a Saipt..
Pause Recording

Set Script Window...

Backup PC Files Als1
Logoff AR+2
Get Mall Al+3
Logon Aledq

Auto execute on open

To automatically execute a TermTalk object when the
AdvanceLink object is opened, highlight its name and check
this option. Only one TermTalk object can be automatically
executed on open, so a script you select for this purpose
replaces any other script that may have been previously
selected.

Auto execute on ciose

To automatically execute a TermTalk object when the
AdvanceLink object is closed, highlight its name and check
this option. Only one TermTalk object can be automatically
executed on close, so a script you select for this purpose
replaces any other script that may have been previously
selected.
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Auto execute on object drop or paste

The TermTalk object for which this option is selected is
automatically executed when an object that is not a TermTalk
script is dragged and dropped into the AdvanceLink
window. If no script is designated for this purpose, file
transfer is initiated as described in Chapter 2. Only one
TermTalk object can be automatically executed on object drop
or paste, so a script you select for this purpose replaces any
other script that may have been previously selected.

The TermTalk manual lists several commands which can be
used in a script which is executed upon drop or paste to test
and manipulate the dropped or pasted object. See "Working
with HP NewWave" in Chapter 3 and the alphabetical
command reference in Chapter 4 of TermTalk.
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Script Menu

Stop Script
Pause Script

Do Command...

Becord a Script...
Pause Recording

Set Script Windaw...

Set Script Window

To execute a TermTalk object, drag its icon into the
AdvanceLink window. There is no menu command which
performs this function. Once the script has begun execution,
you can use Pause Script to temporarily suspend execution,
or Stop Script to terminate execution.

As in AdvanceLink for Windows, Record a Script does not
open a script window, but records the TermTalk commands
necessary to replicate your actions to a file. This file can be
either saved or discarded when you select Stop Recording.
Once saved, it appears as a TermTalk object in the NewWave
Office.

To record a script into a particular TermTalk object, open the
TermTalk object in the NewWave Office, then use the Set
Script Window command from this menu to establish a link
between the AdvanceLink object and the target TermTalk
object. To record to this object, select Record a Script from
the Control menu of the TermTalk window rather than from
the Script menu of the AdvanceLink window.

Allows you to select a TermTalk script window into which
TermTalk commands which reproduce the actions you
perform in the AdvanceLink window are recorded.

Select TermTalk Script Window

File Transfer Script

] 0K H Cancel |updateH Help |

If the TermTalk object you want to record to is not listed in
the box, it may not be open. Open the object in the NewWave
Office, then click Update to add its name to the list.
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The link between the TermTalk window and the
AdvanceLink window only lasts for as long as the two
windows are open, or until you choose the Set Script
Window command again and link the AdvanceLink window
to a different TermTalk window.
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Task Language Commands 5

These commands are used to record tasks for the NewWave
Agent which involve the use of AdvanceLink. Each
command performs the function of a specific menu
command, keyboard key, or mouse action, and they are
grouped accordingly.

Control Menu
Action Menu
Edit Menu
Settings Menu
Utility Menu
Keys Menu

Log Menu
Script Menu
Keyboard and Mouse
Control Bar
Host Interaction
Miscellaneous

The commands are indexed alphabetically in the Index of this
manual.

The functionality of each command can be determined by
looking up the corresponding user interface element in the
AdvanceLink Reference (MS-Windows) or, where the command
operates differently under NewWave, in Chapter 4 of this
manual. Most command parameters correspond to dialog
box options documented in those places.
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Note Where commands have a list of options, these must be
specified in the order shown, though any not required may be
omitted.

The syntax of commands that display a dialog box

includes an optional question mark after the command name.
This means that a dialog box will be displayed with any
default options you indicate (though none are required), so
the user has the chance to confirm or change these options.
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¥
Control Menu

RESTORE
ADJUST_WINDOW
{ AT origin_point | TO width_integer [BY] height_integer
| AT origin_point TO width_integer [BY] height_integer}
MINIMIZE

MAXIMIZE

]
Action Menu

SAVE

SAVE_AS[?] title_name
REVERT

CONNECT
DISCONNECT

SEND_FILE [?] file_name_string [TO host_file_name_string ]
[ EDITOR_WORD_WRAP | EDITOR_RETAIN_LINES | BINARY |
BACKUP | RESTORE | NEWWAVE_SERIAL_FILE ]
[RECORD_SIZE record_size_integer [BYTES | WORDS]]
[OVERWRITE]

The SEND_OBJECT command is only valid immediately after an
object has been dragged and dropped into the AdvanceLink
window. This is recorded by NewWave Office's task
language commands. If the object is to be pasted (rather than
dragged and dropped) into AdvanceLink, use the
PASTE_OBJECT command, listed below under the Edit menu.

SEND_OBJECT [?] [TO host_file_name_string ]

[ BINARY | BACKUP | NEWWAVE_SERIAL_FILE ]
[RECORD_SIZE record_size_integer [BYTES | WORDSI]
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[OVERWRITE]
RECEIVE_FILE [?] host_file_name_string [TO file_name_string ]
[ TEXT_WORD_WRAP | TEXT_RETAIN_LINES | BINARY | BACKUP |
RESTORE | NEWWAVE_SERIAL_FILE ] [OVERWRITE]
PRINTER_SETUP

CONNECTION_ATTRIBUTES [?] [AUTOSHARED {ON | OFF}]
(TITLE title_string ] [COMMENTS comments_string ]

CLOSE [SAVE | DISCARD]

ABOUT?

.

Edit Menu CcuT
COPY
PASTE

PASTE_OBJECT [?]
[TO host_file_name_string ]
[ BINARY | BACKUP | NEWWAVE_SERIAL_FILE ]
[RECORD_SIZE record_size_integer [BYTES | WORDS]]
[OVERWRITE]

CLEAR

COPY_FIELDS

COPY_WINDOW_IMAGE

PASTE_FILE [?] file_name_string

SELECT_ALL

CLEAR_DISPLAY
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CLEAR_LINE

DELETE_LINE

INSERT_LINE
DELETE_CHARACTER
INSERT_CHARACTER {ON | OFF}
CLEAR_ALL_TABS

CLEAR_ALL_MARGINS
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Settings Menu TERMINAL _SETTINGS [?]
[TITLE title_string ]
[EMULATION {HP | ANSI | VT100}1
[TERMINAL_ID id_string ]
[ANSWERBACK answerback_string ]
[SCREENS screen_count_integer ]
[COLUMNS {8011321160}]
[FONT{61718119110112114116}]
[BLOCK_CURSOR | UNDERLINE_CURSOR]
[FULL_SCREEN | TERMINAL_SCREEN]
[CONTROL_BAR {ON | OFF}]
[INDICATORS {ON | OFF}]
[TRANSMIT_FUNCTIONS {ON | OFF}]
[INHIBIT_LINE_WRAP {ON | OFF}]
[INHIBIT_HANDSHAKE {ON | OFF}]
[INHIBIT_DC2 {ON | OFF}]
[PAGE_MODE {ON | OFF}]
[LINE_MODIFY {ON | OFF}]
[BLOCK_MODE {ON | OFF}]
[REMOTE_MODE {ON | OFF}]
[LOCAL_ECHO {ON | OFF}]
[SMOOTH_SCROLLING {ON | OFF}]
[MEMORY_LOCK {ON | OFF}]
[DISPLAY_FUNCTIONS {ON | OFF}]
[AUTO_LINE_FEED {ON | OFF}]
[FORMAT_MODE {ON | OFF}]
[TYPEAHEAD {ON | OFF}]
[CAPS_LOCK {ON | OFF}]
[AUTO_HORIZONTAL_SCROLL {ON | OFF}]
[AUTO_KEYBOARD_LOCK {ON | OFF}]
[DISABLE_BELL {ON | OFF}]
[HOST_CONTROL {ON [ OFF}]
[DDE {ON | OFF}]

36 Chapter 5: Task Language Commands




CONNECTION_SETTINGS [?]
[CONNECTION {SERIAL | MODEM | INT14 | EICON_X25 | BAPI |
HP_TELNET | ADVANCENET}]
[PORT {COM1 | COM2 | COM3 | COM4 |
PORT1 | PORT2 | PORT3 | PORT4}]
[BAUD {300 1600 | 1200 | 2400 | 4800 | 9600 | 19200}]
[PARITY {NONES | EVEN7 | ODD7 | ZEROS7 | ONEST7}]
[ENQ_ACK {ON | OFF}]
[XON_XOFF_INPUT {ON | OFF}]
[XON_XOFF_QUTPUT {ON | OFF}]
[PHONE_NUMBER phone_number_string ]
[HAYES_COMPATIBLE | OTHER_MODEM]
[TONE | PULSE]
[REDIAL {ON | OFF}]
[HARDWARE_HANGUP {ON | OFF}]
[HOST_NODE_NAME host_name_string ]

COLOR_SETTINGS [7]

[COLOR_PAIRS {ON 1 OFF}]

[FOREGROUNDO (red_integer, green_integer, blue_integer )]
[BACKGROUNDO (red_integer, green_integer, blue_integer )]
[FOREGROUND1 (red_integer, green_integer, blue_integer )]
[BACKGROUND1 (red_integer, green_integer, blue_integer )]
[FOREGROUND2 (red_integer, green_integer, blue_integer )]
[BACKGROUNDR (red_integer, green_integer, blue_integer )]
[FOREGROUND3 (red_integer, green_integer, blue_integer )]
[BACKGROUNDS (red_integer, green_integer, blue_integer )]
[FOREGROUNDA4 (red_integer, green_integer, blue_integer )]
[BACKGROUND4 (red_integer, green_integer, blue_integer )]
[FOREGROUNDS (red_integer, green_integer, blue_integer )]
[BACKGROUNDS (red_integer, green_integer, blue_integer )]
[FOREGROUNDS (red_integer, green_integer, blue_integer )]
[BACKGROUNDS (red_integer, green_integer, biue_integer )]
[FOREGROUND? (red_integer, green_integer, blue_integer )]
[BACKGROUND? (red_integer, green_integer, blue_integer )]

e N e S
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FILE_TRANSFER_SETTINGS [?]
[HP3000 | HP9000 | XMODEM]
[STARTUP_SEQUENCE startup_run_string ]
[DEFAULT_FILENAME filename_string ]
[NON_TEXT_AS_BINARY | NON_TEXT_AS_PC_BACKLP]
[SUBSTITUTE_8BIT {ON | OFF}]
[SUBSTITUTE_CONTROLS {ON | OFF}]
[HOST_DC1 {ON | OFF}]
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FUNCTION_KEY_SETTINGS [?]

[F1{

[F2 {

(F3 {

(F4 {

[F5 {

[F6 {

[F7 {

[F8 {

(F9 {

[F10{

[F11{

[F12{

[LOCAL I REMOTE | NORMAL | SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string]} ]

[LOCAL | REMOTE | NORMAL I SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string] } 1

[LOCAL | REMOTE | NORMAL { SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string] } 1

(LOCAL | REMOTE | NORMAL i SCRIPT]

[LABEL_TOP label_string 1 [LABEL_BOTTOM label_string ]
[STRING message_string 1} 1

[LOCAL | REMOTE | NORMAL i SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string] } 1

[LOCAL | REMOTE | NORMAL | SCRIPT]

[LABEL_TOP abel_string ] [LABEL_BOTTOM label_string ]
[STRING message_string] } ]

[LOCAL | REMOTE | NORMAL I SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string 1} ]

[LOCAL | REMOTE | NORMAL | SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string1}]

[LOCAL IREMOTE | NORMAL ! SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string ]} ]

[LOCAL | REMOTE | NORMAL | SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string] } ]

[LOCAL I REMOTE | NORMAL | SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM label_string ]
[STRING message_string 1} 1

[LOCAL I REMOTE ! NORMAL | SCRIPT]

[LABEL_TOP label_string ] [LABEL_BOTTOM labe)_string ]
[STRING message_string]} ]
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KEYBOARD_SETTINGS [?]

[TAB_KEY {TAB | SPACES space_count_integer | RETURN}]

[RETURN_KEY {RETURN | ENTER}]

[BACKSPACE { DESTRUCTIVE | NON_DESTRUCTIVE I DEL } ]

[SHIFT_BACKSPACE { DESTRUCTIVE | NON_DESTRUCTIVE I DEL } ]

(ENTER_KEY {RETURN | ENTER}]

[NUM_PLUS_KEY {PLUS | RETURN | ENTER}]

[EXTENDED_CHARACTERS {ON | OFF}]

[CHARACTER_SET {NORMAL I LINE | MATH [TALIC | BOLD |
USASCII | UK 1 ANSILINE}H

LOG_SETTINGS [7]
(LOG_TOP | LOG_BOTTOM]
[NORMAL | COMPRESSED | EXPANDED]

SCRIPT_SETTINGS [7]

[DONE | SELECT script_name _string
[EXECUTE_ON_OPEN {ON [ OFF}]
[EXECUTE_ON_CLOSE {ON | OFF}]
[EXECUTE_ON_OBJECT_INSERT {ON | OFF}]
[SHOW_IN_MENU {ON | OFF}]

[OPEN | DELETE | COPY | CUT | SHARE]
[CREATE script_name_string ] ]
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|
Utility Menu

BREAK

SOFT_RESET

HARD_RESET

LLINE_MODIFY {ON | OFF}
BLOCK_MODE {ON | OFF}
REMOTE {ON | OFF}
FORMAT_MODE {ON | OFF}
DISPLAY_FUNCTIONS {ON ! OFF}
AUTO_LINE_FEED {ON | OFF}
KEYBOARD_LOCK {ON | OFF}
MEMORY_LOCK {ON | OFF}
TYPEAHEAD {ON | OFF}

SHOW EDIT_BUTTONS I MARGIN_TABS | CONTROL_BUTTONS
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|
Keys Menu

The user function key labels shown in this menu are listed in
the "Keyboard and Mouse" section later in this manual.

SHOW_FUNCTION_KEYS {ON | OFF}

LOCK_FUNCTION_KEYS {ON | OFF}

Log Menu

LOGGING {ON | OFF}

LOG_LINE

LOG_PAGE_FROM_CURSOR

LOG_ALL_FROM_CURSOR

LOG_ALL

LOG_SELECTION

INSERT_PAGE_BREAK

PRINT_LOG

SAVE_LOG [?] file_name_string [OVERWRITE | APPEND]
SAVE_LOG_TO_CLIPBOARD

CLEAR_LOG
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|
Script Menu

Certain menu commands cannot logically be recorded.
Therefore they have been omitted from the task language.
These include Record a Script, Pause Recording, Stop
Recording, and Set Script Window.

DO_SCRIPT_OBJECT object_name_string

DO_COMMANDI(?] [command_string ]

Keyboard and
Mouse

CURSOR
{ UPIDOWN | LEFT IRIGHT | ROLL_UP | ROLL_DOWN | ROLL_LEFT |
ROLL_RIGHTI HOME_UP | HOME_DOWN | NEXT_PAGE |
PREV_PAGE | ROLL_PAGE_LEFT | ROLL_PAGE_RIGHT |
LINE_HOME | LINE_ENDs [count_integer ] }
| {row_integer column_integer [RELATIVE]}
SCROLL_TQ_LINE line_integer
SCROLL_TO_COLUMN column_integer
SELECT {UP | DOWN | LEFT I RIGHT ([count_integer ]}
I {left_column_integer top_row_integer right_column_integer
bottom_row_integer [COPY] }
STOP {ON | OFF}
F1..F12
SHIFT_F1... SHIFT_F8
PF1 .. PF4
TAB

BACKTAB
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By default, the Enter key is the one on the numeric keypad,
not the Return/Enter key on the main keyboard. This can be
reconfigured with the Keyboard/Character Set command on
the Settings menu.

ENTER

RETURN

BACKSPACE

SHIFT_BACKSPACE

|
Control Bar

The edit buttons are duplicated by commands on the Edit and
Action menus, and are shown under those menus. Control
character buttons generate SEND_STRING commands. Tab and
margin settings generate the following commands:

SET_TAB tab_position_integer [ON | OFF]

SET_LEFT_MARGIN margin_position_integer

SET_RIGHT_MARGIN margin_position_integer

I
Host Interaction

SEND_LINE transmission_string [EXPECT expect_string [WAIT
seconds_integer 1]

SEND_STRING transmission_string [EXPECT expect_string [WAIT
seconds_integer 1]

If EXPECT is used to intercept a host response to transmission
from the terminal, it is best to add the string to the SEND_LINE
or SEND_STRING syntax as shown above. If a separate EXPECT
command is used, as shown below, some data may arrive
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from the host before the command is executed and may not
be available for comparison with the expected string.

EXPECT expect_string [WAIT seconds_integer ]

The following command specifies the host prompt for which
the SEND_LINE command waits before sending the
transmission string. The default host prompt, DC1, is
appropriate only for communications with the HP 3000.

HOST_PROMPT host_prompt_string

]
Miscellaneous

The following commands are used to set and retrieve the
values of permanent variables in TermTalk scripts. Note that
string values must be surrounded by double quotes.

SET_VARIABLE global_name_string [TO string_gxpression ]

VARIABLE (global_name_string )

The VARIABLE() function returns the string or long integer
contents of the permanent TermTalk script variable specified.
If the variable does not yet exist, a numeric value of zero is
returned.

To import or export session files to or from MS-DOS files, in
order to share configuration data with AdvanceLink for

Windows users:

CONVERT {FROM file_name_string | TO file_name_string [OVERWRITE]}

Chapter 5: Task Language Commands 45






Index

A

About AdvanceLink 21

Action menu 19

AdvanceLink for NewWave
features 1

AdvanceLink object 1, 8

agent task language 31

Attributes 21

C
Close 21
commands
see Task Language Commands 31
Create a New 8

D
drag and drop 13-16, 17

F
file transfer 13-16, 17

installing link program 12
Function Key Settings dialog box 23

H
host control 11
HPLink 12

iconizing an AdvanceLink object 10
installation instructions 7
installing HPLink 12

L
linked objects 11

N

NewWave Agent 3
O

objects
AdvanceLink 1,8
compound 11
pasting 13-16, 17
TermTalk 1, 8
executing 17

R
Receive File 20
Revert 20

S

Save 19

Save As 20

Script menu 28

Script Settings dialog box 8,9, 11, 15,
24

scripts, see also TermTal manual
automatically executed 11, 26
listing on script menu 26

Send File 20

Set Script Window 10, 28

Settings menu 22

T

task language 3145

Task language commands
ABOUT 34
ADJUST_WINDOW 33
AUTO_LINE_FEED 41
BACKSPACE 44
BACKTAB 43
BLOCK_MODE 41
BREAK 41

Index 47



48

CLEAR 34
CLEAR_ALL_MARGINS 35
CLEAR_ALL_TABS 35
CLEAR_DISPLAY 34
CLEAR_LINE 35

CLEAR_LOG 42

CLOSE 34

COLOR_SETTINGS 37
CONNECT 33
CONNECTION_ATTRIBUTES 34
CONNECTION_SETTINGS 37
CONVERT 45

COPY 34

COPY_FIELDS 34
COPY_WINDOW_IMAGE 34
CURSOR 43

CUT 34
DELETE_CHARACTER 35
DELETE_LINE 35
DISCONNECT 33
DISPLAY_FUNCTIONS 41
DO_COMMANDI 43
DO_SCRIPT_OBJECT 43
ENTER 44

EXPECT 45

F1..F1243
FILE_TRANSFER_SETTINGS 38
FORMAT_MODE 41
FUNCTION_KEY_SETTINGS 39
HARD_RESET 41
HOST_PROMPT 45
INSERT_CHARACTER 35
INSERT_LINE 35
INSERT_PAGE_BREAK 42
KEYBOARD_LOCK 41
KEYBOARD_SETTINGS 40
LINE_MODIFY (ON | OFF) 41
LOCK_FUNCTION_KEYS 42
LOG_ALL 42
LOG_ALL_FROM_CURSOR 42
LOG_LINE 42
LOG_PAGE_FROM_CURSOR 42
LOG_SELECTION 42
LOG_SETTINGS 40

Index

LOGGING 42

MAXIMIZE 33
MEMORY_LOCK 41
MINIMIZE 33

PASTE 34

PASTE_FILE 34
PASTE_OBJECT 34

PF1... PF4 43

PRINT_LOG 42
PRINTER_SETUP 34
RECEIVE_FILE 34
REMOTE 41

RESTORE 33

RETURN 44

REVERT 33

SAVE 33

SAVE_AS 33

SAVE_LOG 42
SAVE_LOG_TO_CLIPBOARD 42
SCRIPT_SETTINGS 40
SCROLL_TO_COLUMN 43
SCROLL_TO_LINE 43
SELECT 43

SELECT ALL 34
SEND_FILE 33
SEND_LINE 44
SEND_OBJECT 33
SEND_STRING 44
SET_LEFT_MARGIN 44
SET RIGHT MARGIN 44
SET TAB 44

SET VARIABLE 45
SHIFT_BACKSPACE 44
SHIFT_F1 ... SHIFT F8 43
SHOW EDIT BUTTONS 41
SHOW_FUNCTION_KEYS 42
SOFT_RESET 41

STOP 43

TAB 43
TERMINAL_SETTINGS 36
TYPEAHEAD 41
VARIABLE 45

Terminal Settings dialog box 21, 22
TermTalk object 8









